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Once Dr. Mina Narula decided that she would become an orthodontist, 
she locked her gaze on her goal and let the universe guide her to it.

As a young girl in India undergoing 
orthodontic treatment, Dr. Mina Narula 
knew even before her braces were off that 
she wanted to become an orthodontist. 
“My orthodontist truly inspired me to live a 
life dedicated to transforming others,” she 
says. “That’s the way I viewed orthodontic 
treatment: the result is more than straight 
teeth—it is the psychological and emotional 
transformation of the patient. I experienced 
that during my own treatment, and I 
recognized that transformation within me.” 

While in dental school, Dr. Narula entered 
a beauty contest on a whim. When she 
was declared the winner, her picture was 
published in a newspaper with the caption: 
"This is a dentist who dreams of becoming 
an orthodontist." Her orthodontist 
happened to see it, and wrote to her 
saying, “My smile did wonders for you.” 
For Dr. Narula, this was final confirmation 
of her chosen vocation. “That really struck 
with me, because it was so true. We have 
far-reaching effects into our lives when 
we touch other people,” she explains. “It 
reinforced to me that orthodontics is a 
real transforming life. I never looked back 
after I decided this was what I wanted to 
do. So I give all credit to my orthodontist, 
Dr. Pradeet Sahni. He is why I became an 
orthodontist.” 

Dr. Narula’s journey to become an 
orthodontist was unwavering. Fueled 
by a passion to practice to the highest 
standards possible, she remained focused 
on the big picture and compromised 
nothing along the way. “I don’t do things 
half-heartedly, ever,” explains the double-

certified orthodontist with a 15-staff private 
practice and a membership in the exclusive 
Angle Society. She also serves as Assistant 
Professor and Clinical Instructor at Loma 
Linda University. “I have a personal faith 
that we are guided in everything we do. Life 
leads us in a certain direction and we just 
happen to fall into those paths.”

A Singular Ambition
“Once I decided to become an orthodontist, 
I never looked back,” Says Dr. Narula, 
who received her dental and orthodontic 
degrees in India from the All India Institute 
of Medical Sciences in New Delhi, with the 
intention to accept Dr. Sahni’s invitation to 
join him in his practice. Life, however, had 
different plans. 

“I married a guy who wanted to emigrate 
to the United States. So it was decided we 
would move, and since orthodontics was 
my first love, I was willing to do whatever it 
took to continue to practice orthodontics. 
Of course, I was already an orthodontist in 
India, but the state-of-the-art treatments 
and materials we used to read about in class 
were not available in India at that time. I had 
to become an orthodontist all over again 
in the U.S.” It was 1991, and at that time 
she was able to earn her dental degree by 
passing a grueling exam called the “bench 
test.” Ninety-five per cent of those taking 
it would fail. “I took that exam because it 
helped me circumvent four years of dental 
school in America. I wanted to spend the 
minimum time in school because I was 
eager to begin practicing orthodontics. 
And although in the U.S. you can legally 
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Dolphin Headquarters has a new 
address!

In December 2016, Dolphin moved up the 
stree. Our new address: 

9200 Oakdale Ave, Suite 500
Chatsworth, CA 91311 

All other contact info remains the same. 

Dr. Mina Narula, DDS MDS
Center for Orthodontics
Rancho Mirage, California
Customer since 1999
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Dear Dolphin family member:

Welcome! As we work toward a truly 
no-physical-paper future, this newsletter 
is now available in electronic form only. 
Please take the time to scroll and click 
through this current compilation of 
interesting news, tidbits, tips and tricks 
on everything Dolphin. 

In this issue, we are honored to bring 
you an interview with Dr. Mina Narula of 
the Center for Orthodontics in Rancho 
Mirage, California. She tells an inspiring 
story of how, while still a young girl in 
India, orthodontics became her personal 
vocation.

We also bring you a helpful message 
from our Michael Zazucki, Manager of 
Technical Support. Michael provides 
useful tips on how to properly back up 
your Dolphin system data to ensure its 
security on an ongoing basis, and also 
making it possible for our team to assist 
in recovery should you experience a 
crisis (such as a natural disaster to a 
frightening ransomware attack).

Next, meet the Dolphin “Mobile” Team! 
This group talented software coders 
was corralled to create and sustain our 
Dolphin Mobile and MyOrthodontist 
mobile apps. We then offer “Tips & Tricks” 
on Dolphin Management, delivered by 
our long-time and super-popular Dolphin 
certified trainer, Trish Fisher. 

You’ll also find a brief overview on the 
changes and improvements in the new 
re-write of MyOrthodontist app. If you 
haven’t tried the app since the original 
version, it’s imperative you check it out 
again in this new version 3. Lastly, check 
out “What’s New” and “DigiKnow?” 
sections for details on what we’ve been 
up to!

Chester H . Wang,
Director

WHAT'S NEW

Aquarium for Surgery 
Dolphin's patient education software 
is available in a separate, streamlined 
package especially for surgeons. Its 
clinically accurate, 3D animated full-motion 
videos and still images demonstrate 
surgical procedures such as block bone 
graft; sinus lift; implants; and more. 
Aquarium’s surgery content is developed 
under the guidance of Board Certified oral 
and maxillofacial surgeons.

Multiple Language Interface
Aquarium now offers a switchable 
language interface that currently features 
a total of 9 languages: English, French, 
Italian, Spanish, Portuguese, Russian, 
Japanese, Simplified Chinese and 
Traditional Chinese. Future updates will 
continue to add new languages.

Pediatric Library category
The December 2016 update of Aquarium 
added a “Dolphin Pediatric” library 
category, containing movies of interest 
to pediatric dentists and their patients. 
Topics includes flossing, eruption, thumb 

habit appliance, and more. So far, there 
are 37 movies in this category.  

“Upload to YouTube” Wizard in 
Aquarium
A new “Upload to YouTube Wizard” makes 
it easy to post your Aquarium movies to 
your YouTube channel without violating 
the Aquarium End User Agreement. 

To learn more, visit www.dolphinimaging.
com/aquarium.

Dolphin Imaging and Management 
continue to add ortho-pedo tools
Dolphin has been adding pediatric features 
and tools to its Management, Imaging and 
Aquarium products:

Dolphin Management Specialty – Pedo                                                                                   
•	 Manage scheduling and patient 

treatment for pedo and ortho in one 
place

•	 Distinct ledgers and billing for pedo 
and ortho

•	 Effectively track and market to your 
patients for pedo and ortho treatment

Dolphin Imaging:	
•	 Magnify and Spotlight toolbar tools
•	 Pediatric/dental FMX layouts

Aquarium:
•	 Pediatric Library containing 37 pedo-

specific patient education movies
•	 New content added every two months 

These products are joined by a full suite 
of complementary software and services 
for ortho-pedo practices that includes 
mobile and Cloud options. For details visit  
www.dolphinpedo.com.

Dolphin Mobile accommodates both 
iOS and Android with a single version 
An identical feature set for iOS and 
Android was released in Dolphin Mobile 
version 4. For more information about 
Dolphin Mobile, visit www.dolphinimaging.
com/mobile.

What's New in Aquarium
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practice orthodontics as a general dentist, 
I wanted to become certified. So I took the 
test and then spent three years getting my 
orthodontic certification.” During this time, 
Dr. Narula served as a Research Fellow 
in Orthodontics at the Harvard School of 
Dental Medicine; worked as an orthodontic 
assistant; and earned her orthodontic 
certificate from Tufts University in Boston. 

A Dose of Serendipity
Setting up practice and settling down in 
California was ultimately a matter of chance. 
“The bench test was only offered in a few 
states, and California was one of them. So 
I ended up getting my license here, and 
just stayed.” Why Rancho Mirage? “Sheer 
coincidence. My husband and I met a 
friend for dinner in the Coachella Valley, 
and thought, ‘We could settle anywhere, 
why not here?’” And thus was the extent 
of the search for a place to practice and 
call home. “It was not a strong business 
decision as such that we didn’t consider 
the demographic, the competition, the 
school system, etc. We simply fell in love 
with the area, and so looked for a practice 
to buy. Everything just fell into place by 
itself.” Dr. Narula’s husband is a dentist, so 
they bought a practice and began working 
together. “The first thing I bought for my 
practice was Dolphin.”

Why Dolphin?
Always looking to live and practice as fully 
as possible, Dr. Narula regularly attended 
orthodontic meetings and listened to 
industry consultants right from the start. 
“Dolphin dominated the market right from 
the beginning. I loved the team, and so 
I didn’t even look beyond Dolphin. For 
me if my heart feels it is right, I don’t look 
beyond.” Dr. Narula was a big follower 
of the orthodontic business guru Roger 
Levin, who endorsed Dolphin in his 
lectures. “The essence of his message 
was always ‘Never take shortcuts,’ and 
 

‘always do what you believe is going to 
be the right thing for your business, even 
if it hurts, financially, in the beginning.’ 
He would say that Dolphin Imaging is 
the best of the imaging software.” This 
reinforced to me that if I want to practice 
orthodontics to the level I want, and with 
the dedication I have toward it, then I was 
not going to take any shortcuts.”  

When asked what she values most about 
Dolphin, Dr. Narula does not hesitate in 
her reply. “Any practicing orthodontist 
will tell you that orthodontics is an 
art, a science, and a business—three 
completely different but integral aspects 
of a practice. Dolphin ties all three of 
them together. Literally, you cannot run 
one without the other. You have to run 
the business of orthodontics successfully 
in order to enjoy it. You have to treat it 
as a science—only then will you get 
predictably good results. And you have 
to enjoy the art part of it, as only then 
will you get unique results that you will 
customize. Dolphin is able to do each 
and every one of them for me seamlessly, 
and ties them all together.” 

Giving Back
Dr. Narula maintains a close relationship 
with the Coachella Valley dental community. 
After being approached by several dentists 
for guidance on their own orthodontic 
patients, she began offering CE courses 
to teach them how to incorporate 
orthodontics into their practice. 

“I figured out a long time ago that there 
will always be a section of orthodontics 
that will done by the general dentist,” she 
explains. “So I wanted to educate them on 
where was the cutoff line between when 
they could stay profitable in their own 
practice, and when they should refer to the 
specialist.” The courses cover areas such 
as diagnosis through CBCT, permanent 
retainer placement, and Invisalign. 

It wasn’t long before she realized that 
general dentists and their staffs were 
lacking in management training, so she 
began holding management classes. “I 
started bringing in experts to speak on 
topics such as taking a new patient call; 
customer service; and team morale.”

Members of all service industries 
are acknowledged at the Center for 
Orthodontics with a program called Smiles 
from Within that offers a heavy discount 
for orthodontic treatment. This includes 
not only the dental and medical doctors 
and staff, but also nurses; teachers; 
firefighters; police; and first responders. 
“It is our way of thanking them for leading 
a life of service,” explains Dr. Narula.

Advice for New Grads
Teaching at Loma Linda brings Dr. Narula 
in contact with orthodontic residents on a 
regular basis. “I always encourage residents 
to rotate through my office to see how we 
do it and experience the energy and power 
of orthodontics. I tell them that you have to 
love to be a lifelong learner, and you have 
to enjoy your growth as you are learning. 
If you feel the need to grow to keep up 
with competition, you will never be happy. 
Orthodontics as a field is changing radically. 
You have to love the field in order to keep 
up with it. I tell my residents to love every 
aspect of it—the business part, the science 
part, the technology part, the customer 
service part, the patient management, that 
psychology that goes into it, what goes into 
making your team special—every aspect of 
it. My biggest advice is not to compromise 
on something you are going to love doing. 
What they actually eventually end up doing 
is up to them, but I can only tell them what 
should be in their minds, and the thought 
process that should guide their actions.” 
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Beverly Hills Face Workshop: Orthodontics & Orthognathics for Facial 
Rejuvenation 

Los Angeles: June 6-9, 2018  
Bilbao, Spain: September 12-15, 2018

The Beverly Hills Face Workshop is a 4-day, hands-on course for orthodontists and 
orthognathic surgeons. Conducted by Drs. Dan Grauer (orthodontist) and Robert 
Relle (orthognathic surgeon), the course provides orthodontists and orthognathic 
surgeons with a practical system for evaluating, planning, predicting, and achieving 
successful results when treating the dentofacial patient. All attendees are offered 
trial versions of Dolphin 3D and 3D Surgery software. Limited space is available. Visit 
www.bhfaceworkshop.com for details and to register.

MESSAGE FROM DOLPHIN SUPPORT

by Michael Zazucki 

The biggest challenge we face in Support 
is not being able to assist a client when 
they do not backup their data. The 
security of your practice data is vital to 
your business so it’s important to ask 
yourself, “Am I backing up properly?”

Your Dolphin software requires two 
primary areas to be backed up regularly: 
•	 The SQL database, which contains 

contracts, ledgers, treatment notes, 
scheduled appointments, questionnaire 
answers, and much more.  

•	 The working directory (located on 
your server), contains letter templates, 
patient images, cephalometric analysis 
data, custom reports and other vital 
information.

Dolphin Imaging contains built-in tools 
that will back up your SQL database by 
default, but you must manually backup 
the working directory. It is critical that 
the working directory is being backed up 
to a safe location on a regular basis. To 
achieve this, you will need to work with 
your local IT to setup a process that saves 
it to a separate hard drive.

Here’s how our SQL backup works:

•	 Dolphin Imaging (Premium) only – 
When you close Dolphin Imaging you 
will receive a prompt that requires you 
to initiate the backup process if it has 
not been run in the past 24 hours.

	 When you click “Pre-backup and 
Exit” Dolphin Imaging creates a 
backup of the database under your 
server’s working directory named 
DolphinPlatformBackup.zip

	 Beginning with version 11.8, the 
backup will run automatically once you 
close Dolphin. Please note if you also 
use Dolphin Management, this feature 
is disabled in Imaging and managed 
through your Management system. 

•	 Dolphin Management – The SQL 
backup is tied to the End of Day (EOD) 
and End of Month (EOM) processes. 
(It is important to note that this feature 
can be disabled.) If you do not have a 
3rd party SQL backup solution, make 
sure the system’s default backup 
is enabled by going go to Tools > 
Options > General (tab) > and confirm 
the option “Skip the Safe Backups at 
EOD” is NOT checked.

	 With this option enabled Dolphin 
Management creates a safebackup.
zip located in the Dolphin\Working\
Data directory on your server at the 
beginning of the EOD and EOM 
process. 

Since EOD is run once per day, I 
recommend running a mid-day backup 

when you close for lunch. To do this, go to 
File > Backup. 

This process will take approximately 5 
minutes. It will provide additional security 
and greatly reduce the burden of having 
to manually reenter all of the morning 
transactions should an incident occur.

Unfortunately, during my tenure at Dolphin, 
I have worked with numerous customers 
that have lost anywhere from a few hours 
to several years of data because they 
failed to properly back up their systems. 
When an event like this occurs we want 
you to be protected. If you are unsure 
whether your local tech is backing up 
the correct data, please have them call 
Dolphin Support to review the procedure. 

Backing Up Your Data

Michael Zazucki 
Manager of Dolphin 
Support

Mike is originally from Flat 
Rock, Michigan, a small 
town south of Detroit. His 
fascination with computers 
began in high school. He 
holds a BS in Computer 
Information Technology 
and has Comp TIA A+ 
certification. 
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The Dolphin Mobile app for your practice 
and the MyOrthodontist app for your 
patient were delivered into the world by 
Dolphin Management, where they were 
nurtured to support the appropriate 
elements of other Dolphin product lines. 
Soon it became apparent that the apps 
needed a dedicated team to bring them 
to full maturity within the special space of 
mobile technologies.  

Dewitt Blankenship, now manager of 
Dolphin’s practice management, mobile 
and web software products, was 
formerly a Dolphin Management software 
developer directly involved with the 
creation of Dolphin Mobile version 1. “I can 
appreciate the challenges that our mobile 
development team gets to work through 
every day,” he says. “I’m proud of how 
quickly our mobile team has adapted to 
recent technology changes we’ve made, 
and the improved quality of the software 
they’ve created as a result.” 

The Team
Rohit Purohit has been with Dolphin 
since 2002, when he was hired onto 
the Dolphin Imaging development team. 
Soon after he was invited to work on the 
then-new AnywhereDolphin—Dolphin’s 
record-sharing service—and he jumped 
at the chance. “I realized the revolutionary 
potential of AnywhereDolphin, and that it 
would provide me enormous opportunity 
to learn new software technologies and 
improve my skills,” he explains. “The 
concept of AnywhereDolphin came 
from the idea of going paperless, and 
that users don’t have to wait for days to 
share their information with others.”  His 
position on the Mobile team represents 
the conduit between MyOrthodontist and 
AnywhereDolphin, which is where the 
backend of the app is housed and where 
customers go to setup and customize the 
app for their practice. Rohit earned a BS 
in electrical engineering in his native India, 
followed by an MS in Computer science at 
the University of Iowa. 

Yasanthi Ranatunga was brought onto 
Dolphin in 2013 as a Mobile Software 
Engineer specifically because she was 
proficient in the computer language 
necessary to optimally design the front-
end of MyOrthodontist. “MyOrthodontist 
was in initial development stage at the time, 
and though I worked on both the back-
end and the front-end of the application, 
my main task was to work on the design 
for the user experience, it was a big hit 
when we’ve announced the upcoming 
(first) release of Myorthodontist app during 
our 2014 Dolphin Meeting, Chicago” 
she says. Currently she is working on 
both Dolphin Mobile and MyOrthodontist 
mobile apps. Yasanthi immigrated to the 
United States from Sri Lanka in 2012 as 
a “Green Card Holder” with her family. 
She had worked as a full-stack software 
engineer in Sri Lanka for more than six 
years after graduating from the BCS, The 
British Chartered Institute for IT (UK).

Andy Barajas joined Dolphin in 2015 
to work directly on Dolphin Mobile, fine-
tuning and ultimately redesigning the user 
interface. These days, he works on both 
apps. “I am the Lead Mobile Developer, 
working on both Dolphin Mobile and 
MyOrthodontist,” he offers. Working 
closely on a daily basis with Rohit and 
Yasanthi, one of his main responsibilities is 

to manage the tasks for new features and 
bug fixes and distribute to the rest of the 
team. “The focus of my work on the apps 
is to create a sleek user interface that is 
snappy for a great user experience.” Andy 
graduated from University of California 
at Santa Barbara with a BS in computer 
science. A self-professed fighting game 
junkie, his first job out of school was 
programming a video game within the 
fighting genre called Skullgirls by Lab Zero.

The Rewards
All three are problem solvers by nature, 
and find fulfillment in creating a new 
design that improves the user experience. 
They also enjoy troubleshooting on how 
to make it even better. “We recently 
introduced an important feature that was 
taking 30 seconds to load,” says Andy. 
“No doctor is going to be okay with 
waiting that long. So, I worked on it and 
eventually reduced it to two seconds. 
That was really rewarding.” Along with 
seeing his work quantifiably improve the 
performance of the app, Andy enjoys 
the ongoing challenges of working with 
technology and the learning opportunities 
that go with them. “I find great satisfaction 
when I compute something that works the 
way I want it to,” says Rohit. “I also enjoy 
helping customers solve problems.”  

The Dolphin Dynamic
The Mobile team members make no 
secret that the culture at Dolphin adds 
to their job fulfillment. “I feel like I am in a 
family,” says Yasanthi. “Everyone has been 
warm and welcoming from the start. My 
team members and even those from other 
departments went out of their way to help 
me and make me feel comfortable. I am 
so happy.” 

Like the devices it develops for, the Mobile team is small yet powerful.

The Mobile Team
EMPLOYEE PROFILE

Dewitt Blankenship
Manager of Dolphin's Mobile Team

Yasanthi 
Ranatunga

Andy 
Barajas

Rohit 
Purohit
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TIPS & TRICKS - DOLPHIN MANAGEMENT

Add special appointment statuses to 
help you organize your patient flow.

For example, all patients scheduled in the 
New Patient chair can go into their own 
GPS Status and get their own message 
when the software knows they are “here.” 
When they walk up to the keyboard and 
enter their name into the system, it will put 
them in the Exam GPS status. This helps 
the practice better handle the flow of new 
patients.

All of the patients scheduled in any chair 
other than Exam would go into Reception 
(W) and all patients scheduled in the Exam 
column would go into the Exam GPS 
status.

How do I get there? How do I do this?

First create the status under Edit  
Scheduling  Appointment Status.

Click on the New button.

Correct the order in the GPS under Edit   
Scheduling  GPS Setup.

Scheduled must remain first in the list and 
Dismissed Last. My “dismissed” is renamed 
as “Completed” in the screenshot.

Once these steps are completed, you 
can tell the software which chairs go 
into which status.  The exam status can 
also be added to the GPS detail.

How do I get there? How do I do this?

Go to Edit  Practice  Location

Open the Schedule tab under your location.

Choose the chairs that are affected by 
the appointment status change.  If you 
make the Exam status be after the default 
waiting status, you will only have to 
change the Exam chair status.  If the exam 
status comes before the waiting status, 
you will have to go into each chair and tell 
each chair to go into your “waiting status” 
except the Exam status.

You will want to add this status to the GPS 
detail screen.  You will need to log in as 
the Admin employee to make this change.   

Getting to Know the Tool Bar in 
Dolphin Management
Maximize your Dolphin Management with these tatical treasures 
from the Tool Bar.

Trish Fisher 

Trish has worked in 
orthodontics since 2002. 
As a clinical technician 
and treatment coordinator 
she gained experience 
in scheduling, finances, 
insurance, digital imaging 
and cephalometric 
tracing.

She received her BA in 
Management Accounting 

with minors in both Computer Science 
and Information Studies from Alverno 
College, graduating with honors. Trish is a 
Dolphin trainer based in Wisconsin, where 
she and her husband own a consulting 
firm called Business Information and 
Technology Solutions (BITS).
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To view Tips & Tricks from  
past issues of Echoes, visit

www.dolphinimaging.com/Media/
EchoesNewsletter

 (Continued from page 2)   WHAT'S NEW

You can sharpen your Dolphin software skills with additional training?

Have you recently upgraded your Dolphin system? Hired new staff? Purchased new 
digital equipment? Feeling like it’s time for a brush-up on the basics? Training isn’t just 
for beginners. The Dolphin Training team offers on-site or phone training sessions in 
customized packages to suit your ongoing needs. Continuing Education credits are 
available depending on individual state approval, including Canada. For details contact 
training@dolphinimaging.com or call 800.548.7241.

 (Continued from page 6) 

Dolphin Management and 
MyOrthodontist have their own 
Facebook Users Groups
Dolphin Management and MyOrthodontist 
customers now each have a closed 
environment in which to discuss the 
software with each other. The Users 
Groups are meant to be a forum for users 

to freely communicate with peers and 
share their experiences with the software. 
We encourage all Dolphin Management 
and MyOrthodontist practices to join 
by visiting www.facebook.com/groups/
myorthodontist and/or www.facebook.
com/groups/DolphinManagement.

New in Dolphin Imaging 11.9   
•	 A new “Color Match” tab in the 

“Enhance image” window allows 
you to pick an image from a different 
timepoint, and auto-adjust the color 
of the current image to more closely 
match the look of the corresponding 
original image. 

•	 Duplicate Patient Warning system will 
alert you if you create a new patient that 
has the same first name, last name, 
and date of birth as an existing patient. 

•	 Three new surgical analyses: [FACE], 
[Ortomax], and [Diez & Bonilla].

•	 Support for MyOrthodontist mobile 
app for patients.

•	 Download patients directly from 
AnywhereDolphin with the free viewer.

•	 Share a patient via AnywhereDolphin 
from directly inside Dolphin Imaging.

 Coming in Dolphin Imaging 11.95
•	 “Submit to BeamReaders” button 

allows you to transfer a patient’s 
record, along with work-order notes 
to BeamReaders for a radiology 
report and/or image portfolio. This 
feature requires an AnywhereDolphin 

account, free to members of the 
Dolphin Service Club. 

•	 New “Surgery” button on tool bar to 
enter 3D Surgery module.

•	 Discard color from imported color 3D 
study models

•	 Bibliographic citations added to 
Norms in the Custom Analysis Editor

Coming in Dolphin Imaging 12:
3D Drill Guides
3D Drill Guides is designed to be an add-on 
software module to Dolphin 3D, expanding 
its existing Implant Planning tools to create 
an all-in-one implant treatment planning 
program. By adding 3D Drill Guides to your 
3D system, you gain the ability to plan guided 
implant cases from start to finish in your 
own office. Choose from a comprehensive 
library of implants to add to a patient’s 3D 
image for precise treatment planning, then 
with the 3D Drill Guides module you can 
create printable implant surgical guides. 
Print the guides yourself, or send to your 
favorite lab. No per-case fees. This software 
is now in design evaluation. Interested 
in evaluating the software at no charge?  
Email BetaDI@dolphinimaging.com for info.  

Also under Edit -> Practice ->Locations -> 
Options add a special message to the new 
appointment status if desired.  Remember 
you can also create a PowerPoint slide if it 
is installed on your sign in computer. 

Occlusal collision 
colormap
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New “Dolphin in Research” web page
A source of pride here at Dolphin is 
that for decades, researchers and 
clinicians have used Dolphin software 
in their academic studies and published 
them in clinical journals worldwide. A 
new page on our web site has indexed 
hundreds of them going back to 1988. 
The page is searchable by topic. Go 
check it out at www.dolphinimaging.
com/media/research.

JCO Names Student of the Year 
Award Winner
The Journal of Clinical Orthodontics (JCO) 
announced Dr. Moataz Elmahdy from the 
University of Rochester as the winner 
of the 2017 Eugene L. Gottlieb JCO 
Student of the Year Award. In its second 
year, the award includes more than 
$8,000 worth of prizes from American 
Orthodontics, JCO, and Dolphin Imaging 
& Management Solutions. The winner 
of the inaugural 2016 Award was Dr. 
Krystian Jarosz of Rutgers University. 

New Dolphin Imaging and Management 
integrations: 

•	 EasyRx is a Cloud-based digital patient 
appliance prescription management 
application for orthodontic practices 
and labs. For details on how it works 
visit www.easyrxortho.com. 

•	 Protected Trust is an IT security 
company that offers an innovative 
email encryption tool that helps 
businesses like yours adhere to 
regulatory demands such as HIPAA.

•	 PayWithBreeze, a new credit card 
processing service from OrthoBanc, 
is now supported by Dolphin 
Management. 

1st Dolphin Mediterranean Meeting in 
Rhodes, Greece 
Infolab (Dolphin distributor in 
the Mediterranean) held the 1st 
Mediterranean Dolphin Meeting in 
Rhodes, Greece on September 22, 2017. 
The event occurred the day prior and 
in conjunction with the first event of 
GREESLO (Greek Society of Lingual 
Orthodontics).

2017 Brasil Dolphin Meeting, Sao 
Paulo 
Renovatio (Dolphin distributor in Brazil) 
commemorated 10 years of collaboration 
with Dolphin by holding a Dolphin Meeting 
for local customers. The event took place 
on September 5, 2017 at the World Trade 
Center in Sao Paulo, Brazil, on the first day 
of COBRAC. Visit the Renovatio Facebook 
page here.

The biennial Australia Dolphin 
Meeting
The 2017 Australia Dolphin Meeting was 
held in Brisbane, Queensland, Australia 
on November 10-11 at the Rydges South 
Bank Brisbane.  Members of the Dolphin 
U.S. team traveled down under to assist in 
conducting classes and helping customers 
in the Computer Lab.

Dolphin Master 
Class with 
Dr. Simonas 
Grybauskas

Dolphin distributors Major Partner and 
Dolphin Spain together organized a 
Dolphin Master Class held in Haarlem, 
Netherlands, on November 29th , the 
day prior to the start of BSSO. The class 
was held at Stemples restaurant, and 
featured Dr. Simonas Grybauskas, who 
presented a detailed demonstration of 
the new Head Orientation feature in 
Dolphin 3D. 

Excellence in Digital 
Orthodontics  
with Dr. Dan Grauer
October 10-13, 2018
Los Angeles

Dr. Dan Grauer will be holding a 4-day 
workshop on digital orthodontics. The 
program will be organized into parts: 

1.	Diagnosis and treatment planning

2.	Imaging, from photos to customized 
appliances

3.	Customized labial

4.	Customized lingual, aligners and 
retainers 

AnywhereDolphin is FREE to all Dolphin Service Club members?

One of the many perks of the Dolphin Service Club is free access to the AnywhereDolphin 
record-sharing service. AnywhereDolphin allows you to effortlessly and securely share your 
Dolphin records with referrals and patients over the Internet. Shared records include x-rays, 
photos, treatment request forms, and notes. You can exchange records between your 
AnywhereDolphin account and your Dolphin Imaging database; give referrals and patients 
access to the records that you specify; create templates for customized notes; track who 
accessed what records and when; and more. And to top it off, recipients can view the 
records online without the use of Dolphin software.  

ervice Club

ervice Club
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Version 3 of the MyOrthodontist mobile 
app was released in October, adding 
design and functionality improvements to 
both the front and back ends of the app.  
Improvements include a new look and feel 
plus sleeker navigation and performance. 
It also now runs in a native environment in 
both iOS and Android, resulting in a faster, 
more responsive interface. 

Other new features include:
•	 Create customized primary and 

accent colors when setting up you 
MyOrthodontist theme

•	 Support for adding custom social 
media links

•	 Simplified account creation by 
stepping users through the process, 
whether they are at the practice; 
received an invitation email; or they 
need to create an account by entering 
data manually

•	 Fingerprint login

•	 Ability to sign questionnaires

•	 Practice rating system

•	 Push notifications to remind your 
patients about appointments/new 
content

For more detailed info on this new release, 
click here. 

The MyOrthodontist mobile app gets 
patients involved in their treatment by 
putting your practice in the center of their 
lifestyle. Downloading MyOrthodontist to 
their iOS or Android device will empower 
them to take an active role in their 
treatment, while also enhancing their 
relationship with you and your staff. 

Some Frequently Asked Questions

What is MyOrthodontist?
MyOrthodontist is a mobile app for 
patients and responsible parties, providing 
them access to information about their 
treatment, billing and your practice. Once 
they download MyOrthodontist to their 
smartphone, they have access to:

•	 Patient Information
o	 View future and past appointments
o	 View account balance

o	 Make payments
o	 Complete and sign online 

questionnaires
o	 View photos from Imaging
o	 View Aquarium© patient education 

video

•	 Practice Information 
o	 FAQs
o	 Media files like videos, images
o	 News Items 
o	 Staff bios
o	 Contact info (email, phone)
o	 Submit practice ratings and reviews
o	 Social media such as Facebook, 

Instagram, Google+ and Twitter

Is MyOrthodontist customizable? 
Yes! MyOrthodontist is easily customizable  
for your practice. Using a new 
MyOrthodontist setup screen in 
AnywhereDolphin, you set up your profile 
information: details about the practice, 
doctors and staff. You can also include 
links to web site items such as news, RSS 
feeds, and social media. Personalize the 
app by uploading your logo and choosing 
from over 25 color themes, or create a 
custom one of your own.  

How does it work? Is it secure? 
MyOrthodontist connects to our secure 
AnywhereDolphin site to validate users 
and access data from your server (via our 
Dolphin Ocean Service). Connections 
between your server, AnywhereDolphin 
and the MyOrthodontist app are 
encrypted for security using industry-
standard Transport Layer Security (TLS).

What does it cost my patients to 
download?
The app is free to download from the 
App Store or Google Play.

Does the app have the practice name 
on the App Store or Google Play?
No. The app is listed as MyOrthodontist 
on the App Store or Google Play. Once the 
user logs into the app, your customized 
MyOrthodontist app is displayed.                            

Can my practice use MyOrthodontist 
for mobile access?
No. Dolphin Mobile is our practice-facing 

mobile app, developed specifically for 
use by doctors and staff. For more 
information, visit www.dolphinimaging.
com/dolphinmobile.

What version of Dolphin Management 
is required?
MyOrthodontist requires Dolphin 
Management 6 or higher, or the Dolphin 
Security Utilities 7 or higher. To ensure 
you can take full advantage of the 
latest features of MyOrthodontist, we 
recommend running the most recent 
version of Dolphin Management that is 
available.

I only have Dolphin Imaging. Is 
MyOrthodontist available for me?
Yes! The app is available for Imaging-only 
customers when used in conjunction with 
the free Dolphin Security Utilities. 

PRODUCT HIGHLIGHT
MyOrthodontist Gets a Total 
Rewrite in Version 3.

Got more questions? Feel free to 
contact us at 800.548.7241 or visit 
www.dolphinimaging.com/myortho.

An overhauled user interface and a ton of new features were delivered 
in the recent update to the MyOrthodontist mobile app for patients. 
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AnywhereDolphin gets a fresh new 
look and lots of updates!
The AnywhereDolphin team has released 
a comprehensive update that includes 
a fresh new interface and enhanced 
functionality. Features include:

•	 The choice of a Light or Dark theme

•	 Complete history for each patient log

•	 Reports feature now offers the option 
to look back 90 days

•	 A new “Settings” link contains 
“Change Password” and “Theme” 
selector functions

•	 The ability to view 3D Model 
attachments within AnywhereDolphin 
(no need to download)

•	 And much, much more! 

To see the new AnywhereDolphin, visit 
your account now. 

Are you running the most current 
Dolphin software?
Keeping your Dolphin software up-
to-date is crucial to maintaining the 
accuracy of diagnoses and treatment 
planning; the smooth operation of your 
practice; and the safety of your patients. 
The best way to ensure you always have 
the most current software is to enroll in 
the Dolphin Service Club, which not only 
sends you automatic software updates 
with unlimited support, but lots of other 

perks as well. (Visit www.dolphinimaging.
com/serviceclub for details.)  

As of November 30, 2017, the most 
current Dolphin releases are:

•	 Dolphin Imaging – 11.9 build 24 

•	 Dolphin Management – 8 build 6479

•	 Aquarium – 3.4 build 6486

•	 Dolphin Mobile for  
iOS and Android – 4.5.0003

•	 MyOrthodontist – 3.0.0003

DigiKnow...You can connect with 
Dolphin on social media?
Dolphin has been growing its presence 
on social media! Come join us to find 
out what’s new, where we’re at, and 
participate in conversations on all sorts 
of topics. 

•	 Facebook:  
Facebook.com/DolphinImaging

•	 Twitter:  
Twitter.com/DolphinNews

•	 Google+: 
Plus.google.com/+DolphinImaging

•	 YouTube:  
Youtube.com/DolphinTalk

•	 Instagram:  
Instagram.com/dolphinimaging

Join us in Las Vegas for the 2018 Dolphin Meeting!

The 2018 Dolphin Meeting, Las Vegas, is right around the 
corner! Join us next March 1-3 at the Aria Hotel for our 
annual weekend of learning and fun. Check our web site at 
www.dolphinmeeting.com for details and to register. 
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